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Upoznavanje sučelja
Jedan od zastrašujućih aspekata rada s bilo kojim HTML 

(HyperText Markup Language) editorom je upoznavanje nje-

govog sučelja. Kako HTML editori postaju sve moćniji i funkci-

onalniji, ne iznenađuje to što su njihova sučelja tijekom godina 

postala složenija. Ali, u usporedbi s drugim editorima, sučelje 

Adobe Dreamweavera CS3 uzor je praktičnosti. Niti jedan drugi 

HTML editor ne pruža tako robusnu okolinu za uređivanje s tako 

učinkovitim i intuitivnim sučeljem. Drugi HTML editori zahtijevaju 

da otvorite mnoštvo prozora i paleta različitih veličina da biste 

došli do svih značajki, što znači da ćete neprestano tražiti alat koji 

vam je potreban. Međutim, Dreamweaver CS3 koristi sustav pri-

lagodljivih paleta te grupa paleta kako bi zadovoljio vaše potrebe 

ovisno o kontekstu onog što radite. To štedi prostor na zaslonu i 

olakšava upoznavanje sučelja. Iako se sučelje Dreamweavera CS3 

može na početku činiti zastrašujućim, učenje kako ga koristiti vje-

rojatno je jedan od lakših izazova koji su pred vama.

Ovo će vas poglavlje provesti kroz sučelje programa. Pored 

toga, objasnit ćemo vam kako namjestiti važnije postavke i 

konfigurirati Dreamweaver CS3.

Možda ste nestrpljivi da započnete s nekom od vježbi iz kasni-

jih poglavlja, ali prvo biste trebali pregledati ovo poglavlje 

da biste mogli prepoznati alatne vrpce, palete i prozore koje 

ćete koristiti kroz cijelu ovu knjigu.

	 Razgledavanje sučelja	 13

	 Povratak	  
	 podrazumijevanog	  
	 radnog prostora 	 26

	 Spremanje rasporeda	  
	 paleta i prozora	 26

	 Zadavanje	  
	 podrazumijevanog 	  
	 preglednika 	 27

	 Korištenje prečaca	  
	  na tipkovnici 	 28

DWCS3.indb   12 18.9.2008   7:25:04



13Poglavlje 2 : Upoznavanje sučelja

U Windows sustavima, sučelje Dream
weavera CS3 sadržano je unutar integri-
ranog radnog prostora, što znači da su 
prozor dokumenta i sve palete smješteni 
unutar većeg prozora. Ovaj raspored može 
olakšati rad s više dokumenata i paleta jer 
se palete ne pomiču po čitavom zaslonu 
kao odvojeni objekti. Integrirani radni pro-

stor na raspolaganju je samo korisnicima 
Windowsa. Budući da postoje značajne 
razlike između inačica Dreamweavera CS3 
za Windowse i Macintosh, u ovom odlomku 
bit će opisana oba sučelja. Bez obzira na 
operativni sustav, sučelje se sastoji od šest 
glavnih dijelova.

Razgledavanje sučelja

Vrpca Insert

Property Inspector

Alatna vrpca 
dokumenta Skupina paleta

Prozor dokumenta Paleta

Sučelje inačice za Windows

Šest glavnih elemenata sučelja Dreamweavera CS3 za Windowse su sljedeći: vrpca Insert, 
alatna vrpca dokumenta, prozor dokumenta, Property inspector, palete i skupine paleta. 
Podrazumijevano, svaki put kad otvorite Dreamweaver CS3, on prikazuje pozdravni zaslon 
(koji ćete uskoro upoznati).
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14 Adobe Dreamweaver CS3 : praktični priručnik

Sučelje inačice za Macintosh

Vrpca Insert

Property Inspector

Alatna vrpca 
dokumenta Skupina paleta

Prozor dokumenta Paleta

Šest glavnih elemenata sučelja Dreamweavera CS3 za Macintosh također su vrpca Insert, 
alatna vrpca dokumenta, prozor dokumenta, Property inspector, palete i skupine paleta. 
Podrazumijevano, svaki put kad otvorite Dreamweaver CS3, on prikazuje pozdravni zaslon.
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15Poglavlje 2 : Upoznavanje sučelja

Pozdravni zaslon
Pozdravni zaslon (Welcome Screen) pruža 
brz način za obavljanje uobičajenih poslova, 
poput otvaranja nedavno korištenih dato-
teka, izrade novih dokumenata, pristupanja 
predlošcima i još mnogo toga. Možete čak 
pristupiti i nekim vodičima te servisu Adobe 
Dreamweaver Exchange (o njemu ćete nau-
čiti više u  poglavlju 14) pritiskanjem odgo-
varajuće veze. Pozdravni zaslon je dobar 
način za uvođenje u Dreamweaver CS3 jer 
ovim uobičajenim poslovima daje vizualni 
prikaz.

On se ponaša i izgleda jednako i na Macin
toshu i u Windowsima, osim što je na Macin
toshu pomični prozor, a u Windowsima je to 
dio integriranog radnog prostora.

Ako iz bilo kojeg razloga ne želite koristiti 
pozdravni prozor možete ga deaktivirati 
potvrđivanjem polja Don’t show again 
u njegovom donjem lijevom kutu ili oda-
biranjem Edit > Preferences > General, 
odnosno Dreamweaver > Preferences 
> General (na Macintoshu) i uklanjanjem 
oznake za potvrdu iz polja Show Welcome Screen, kao što je prikazano na slici. Obje 
opcije rezultiraju time da se Dreamweaver CS3 otvara bez prikazivanja pozdravnog zaslona.

Vrpca Insert
Vrpca Insert sadrži ikone objekata i mjesto ne na kojem se jednim pritiskom tipke miša 
mogu izvesti mnoge operacije. Ako postavite pokazivač miša iznad ikona na vrpci Insert 
i zastanete na trenutak, pojavit će se podsjetnik alata koji objašnjava što čini pojedina 
ikona.

Vrpca Insert je podrazumijevano podijeljena na kategorije u obliku kartica, a svaka kartica 
sadrži različiti skup srodnih ikona. Na primjer, da izrađujete obrazac, pritisnuli biste jezičak 
kartice Forms za pristup svim objektima obrasca koji su raspoloživi u Dreamweaveru.
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16 Adobe Dreamweaver CS3 : praktični priručnik

Ako vam se ne svi-
đaju kartice, katego-
rije na vrpci Insert 
možete prikazati i na 
pomoćnom izborniku. 
Pritisnite gumb Panel 
Options i odaberite 
opciju Show as Menu. Zatim ćete 
kategorije objekata moći odabrati 
s padajućeg popisa s lijeve strane 
vrpce Insert. Da biste vratili suče-
lje s karticama, s izbornika Panel 
Options odaberite Show as Tabs.

Mnoge stavke s vrpce Insert također 
se nalaze u izborniku Insert na vrpci pri vrhu prozora. Vrpca Insert pruža alternativu jedno-
strukog brzog pritiskanja naspram odabira opcije s izbornika. Možda vam bolje odgovara 
pritiskati gumbe, a možda ćete radije pristupati izborniku. Nema ispravnog ili neispravnog 
načina – to je samo pitanje osobnih sklonosti.

 
Tipovi kategorija vrpce Insert
Vrpca Insert organizirana je u šest kategorija i sadrži dodatno područje za skupinu Favorites. 
Svaka kategorija sadrži skup srodnih objekata. Evo kratkog opisa svake kategorije na vrpci Insert.

Kategorija Common sadrži najčešće korištene objekte u Dreamweaveru CS3, uključujući slike, 
tablice, oznake <div>, jednostavne prijelaze, Flash objekte i tako dalje. Često ćete ju koristiti.

Kategorija Layout zaista je korisna te ćete se često zateći kako je upotrebljavate tijekom 
izrade stranica. Ova paleta omogućava odabiranje različitih režima za uređivanje, rad s 
apsolutno pozicioniranim oznakama <div> i još mnogo toga. O ovim ćete pojedinostima 
učiti u poglavlju 9.

Kategorija Forms sadrži sve elemente bitne za izradu obrazaca na Web stranicama. Ti 
objekti uključuju tekstualna polja, gumbe, izbornike i, nove u Dreamweaveru CS3, Spry 
kontrole za provjeru ispravnosti. O ovim ćete elementima učiti u poglavlju 13.

Kategorija Data nova je u Dreamweaveru CS3. Ona omogućava umetanje Spry podat-
kovnih objekata te drugih dinamičkih elemenata kao što su skupovi zapisa, ponavljajuća 
područja i obrasci za umetanje zapisa i ažuriranje.

Odaberite za povratak na sučelje s karticama
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17Poglavlje 2 : Upoznavanje sučelja

Kategorija Spry također je nova u Dreamweaveru CS3. Sadrži gumbe za izradu Spry stra-
nica, uključujući Spry objekte podataka i kontrole (engl. widgets). Spry kostur se koristi za 
izradu složenih internetskih aplikacija i naprednija je tehnika namijenjena iskusnim Web 
dizajnerima. Međutim, ipak će u poglavlju 20 biti opisane osnove korištenja skupine Spry.

Kategorija Text pruža lak način za oblikovanje teksta na stranici, iako ćete u tu svrhu vje-
rojatno najčešće koristiti Property inspector jer nije praktično otvarati kategoriju Text na 
vrpci Insert svaki put kad poželite oblikovati tekst.

Kroz cijelu ćete ovu knjigu učiti kako i kada upotrijebiti mnoge objekte s vrpce Insert. Za 
sada, ovo je bio samo kratak pregled da biste za njih saznali.

Dodavanje kategorije Favorites na vrpcu Insert
Dok budete izrađivali Web stranice, mogli biste doći u situaciju da se neprestano trebate 
prebacivati između različitih kategorija na vrpci Insert, što može postati zamorno, posebice 
ako uvijek koristite isti skup stavki. Kako budete sticali sve više iskustva s Dreamweaverom, 
spoznat ćete koje objekte vrpce Insert najčešće koristite pa biste mogli smatrati praktičnim 
da svi budu smješteni na jed-
nom mjestu umjesto pod neko-
liko kategorija. Da bi vam malo 
olakšao rad, Dreamweaver CS3 
omogućava da izradite skupinu 
Favorites na vrpci Insert koja 
će sadržavati najčešće kori-
štene stavke.

Kad je otvoren neki doku-
ment, jednostavno desnom 
tipkom miša pritisnite bilo 
gdje na vrpcu Insert i odabe-
rite Customize Favorites da 
biste otvorili dijaloški okvir 
Customize Favorite Objects.

S popisa na njegovoj lijevoj strani možete odabrati najčešće korištene objekte te ih dodati 
u stupac Favorite objects na desnoj strani. Da biste pomicali stavke na popisu, koristite 
gumbe sa strelicama nagore i nadolje a da biste dodali crtu koja razdvaja objekte, pritisnite 
gumb Add separator. Kad završite, pritisnite OK.

Svi vaši omiljeni objekti nalazit će se u kategoriji Favorites koja može ostati otvorena. 
Naravno, trebate li odabrati objekt koji se ovdje ne nalazi, možete pritisnuti jezičak njegove 
kartice ili ga dodati omiljenim objektima ako smatrate da ćete ga često koristiti.
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18 Adobe Dreamweaver CS3 : praktični priručnik

Property inspector
Property inspector je 
osjetljiv na kontekst, što 
znači da se mijenja ovi-
sno o tipu elementa koji 
je odabran na Web stranici. Ako je odabran tekst, u Property 
inspectoru ćete vidjeti svojstva teksta (kao na ovoj ilustraciji) a 
ako je odabrana slika, vidjet ćete svojstva slike.

Bez Property inspectora ne možete mijenjati svojstva mnogih elemenata na stranici pa 
je dobro da bude stalno otvoren. Ako želite da uvijek bude potpuno proširen, pritisnite 
strelicu u njegovom donjem desnom kutu. Kad je Property inspector sažet, nećete moći 
vidjeti sva raspoloživa svojstva.

Alatna vrpca dokumenta
Mnogim opcijama možete pristupiti izravno s alatne vrpce dokumenta koja je smještena 
na vrhu svakog prozora dokumenta. Alatna vrpca dokumenta sadrži niz gumba i pomoćnih 
izbornika koji omogućavaju mijenjanje pogleda na dokument, zadavanje naslova stranice, 
probno pregledavanje stranice u pregledniku i rad s poslužiteljem na koji su smještene 
stranice.

Ovako izgleda alatna vrpca dokumenta u Windowsima.

Pogled Design Vizualni pomagači Provjera stranice

Naslov

Pogled Code

Pogled Code and Design

Osvježavanje 
pogleda Design

Probni pregled/uklanjanje  
pogrešaka u pregledniku

Opcije pogleda Provjera ispravnosti koda

Rad s datotekama

Ovako izgleda alatna vrpca dokumenta na Macintoshu.

Sažimanje/proširivanje
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19Poglavlje 2 : Upoznavanje sučelja

NAPOMENA: Ponavljanja u sučelju
Dok budete proučavali Dreamweaver CS3 primjetit ćete neka ponavljanja 
u sučelju. Na primjer, sliku možete umetnuti pritiskanjem gumba Image 
na vrpci Insert ili odabirom opcije Insert > Insert Image. Objekte možete 
poravnati koristeći Property inspector ili odbiranjem opcije izbornika. 
Različite mogućnosti ponekad mogu biti praktične, ali također može biti 
zbunjujuće učiti program koji pruža dva ili tri načina za obavljanje istog 
posla. Ne zaboravite da nema ispravnog ili pogrešnog načina. Tijekom 
rada u Dreamweaveru otkrit ćete koje vam metode najbolje odgovaraju.

Kao što možete vidjeti, alatna vrpca dokumenta na Macintoshu u biti je jednaka onoj na 
Windowsima. Sljedeća tablica opisuje što rade svi ovi gumbi:

Gumbi na alatnoj vrpci dokumenta

Gumb Opis

Code View Pogled Code prikazuje kôd koji tvori stranicu. Možete ga upo-
trijebiti ako želite izravno urediti kôd bez upotrebe posebnog 
editora teksta, kao što je BBEdit tvrtke Bare Bones Softvare ili 
Adobeov HomeSite. Pogled Code je koristan kada se naviknete 
na rad sa izvornim kodom ili kad morate izraditi ili modificirati 
prilagođeni kôd, kao što su JavaScript, ASP (Active Server 
Pages) i drugi. Kroz ovu ćete knjigu imati brojne prilike naučiti 
raditi s pogledom Code

Code and Design Zove se još i pogled Split i dijeli dokument na pola, prikazujući 
i kôd i grafički prikaz stranice. Ovaj je pogled koristan ako želite 
izvesti neke manje promjene u kodu i odmah vidjeti učinak koji 
imaju na stranici.

Design View Pogled Design je podrazumijevani pogled za prozor dokumenta. 
On prikazuje stranicu u WYSIWIG (What You See Is What You 
Get) režimu, što znači da ćete vidjeti slike, tekst i druge multime-
dijalne sadržaje kako ih dodajete stranici. Ovaj je pogled koristan 
ako niste upoznati s HTML-om ili jednostavno ne želite trošiti vri-
jeme na pisanje ili uređivanje koda. On tijekom dizajniranja pruža 
prilično točan pregled kako će stranica izgledati u pregledniku.

Title Ovo polje za tekst omogućava zadavanje naslova stranice. Tekst 
koji u njega upišete pojavit će se na vrhu prozora posjetiteljevog 
preglednika, a neke tražilice ga koriste za opisivanje sadržaja 
stranice. To je također ime koje opisuje stranicu kad je u pre-
gledniku spremite na popis omiljenih stranica. Možete ga zadati i 
u dijaloškom okviru Page Properties.

nastavak na sljedećoj stranici
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20 Adobe Dreamweaver CS3 : praktični priručnik

Gumbi na alatnoj vrpci dokumenta  nastavak

Gumb Opis

File Management Pomoćni izbornik koji omogućava da upravljate datotekama 
lokacije. Koristit ćete ga za slanje datoteka na poslužitelj i preu-
zimanje s njega, njihovo otključavanje i zaključavanje te nadzor 
nad aktivnostima drugih članova tima. Odlično je imati pristup 
svim ovim opcijama izravno iz prozora dokumenta. Kako se 
datoteke šalju na poslužitelj i preuzimaju s njega naučit ćete u 
poglavlju 21.

Preview/Debug 
in Browser

Omogućava odabiranje preglednika u kojem ćete probno pogle-
dati stranicu ili ukloniti pogreške iz JavaScripta. Možete također 
pristupiti dijaloškom okviru Define Browsers za zadavanje novih 
preglednika ili promjenu referenci na preglednike koji su već 
definirani.

Refresh Design 
View

Ovaj gumb osvježava pogled Design. To vam može pomoći 
ako mijenjate stranicu u pogledu Code a promjene ne možete 
odmah vidjeti u pogledu Design.

View Options Ovaj izbornik ima različite funkcije, ovisno o tome jeste li u 
pogledu Code ili Design. U pogledu Code možete postaviti 
prelamanje teksta, prikazivanje brojeva redova, obilježavanje sin-
takse u boji i tako dalje. U pogledu Design možete zadati želite 
li da budu prikazana ravnala i vodilice. U pogledu Split možete 
postaviti opcije pogleda i za Code i Design te zamjeniti njihova 
mjesta tako da pogled Design bude u gornjem oknu.

Visual Aids Pomoćni izbornik koji omogućava uključivanje i isključivanje 
mnogih vizualnih pomagala u pogledu Design. Možete isklju-
čiti prikaz nevidljivih elemenata, rubove tablica, pozadinu CSS 
(Cascading Style Sheets) rasporeda i neke odlične značajke pri-
kaza CSS koda o kojima ćete više naučiti u poglavlju 6.

Validate Markup Ovaj pomoćni izbornik omogućava da provjerite koliko je vaš 
kôd usklađen s raznim HTML i XHTML standardima. Možete pro-
vjeriti trenutno otvoren dokument, skupinu odabranih dokume-
nata ili čitavu lokaciju. Također možete pristupiti raznim opcijama 
za preciznije zadavanje opcija provjere.

Check Page Pruža lak način za provjeru koda u različitim preglednicima i 
njihovim inačicama. Iz ovog pomoćnog izbornika možete zadati 
za koje se preglednike i inačice provjerava usklađenost koda. 
Možete zadati da se kod stranica automatski provjerava svaki put 
kad se otvore. O ovoj ćete značajki više naučiti u poglavlju 21.
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21Poglavlje 2 : Upoznavanje sučelja

Prozor dokumenta
Prozor dokumenta je mjesto gdje se odvijaju sve aktivnosti dok radite na Web stranicama. 
U njemu sklapate elemente i dizajnirate stranice. Prozor dokumenta po izgledu je sličan 
prozoru preglednika. 

Alatna vrpca dokumenta

Pomoćni izbornik za 
zadavanje veličine prozora

Tag Selector Alat Select

Alat Hand

Alat Zoom

Povećanje

Veličina datoteke/ 
trajanje učitavanja
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22 Adobe Dreamweaver CS3 : praktični priručnik

Sljedeća tablica opisuje značajke prozora dokumenta:

Elementi prozora dokumenta

Elementi Opis

Alatna vrpca Svaki prozor dokumenta ima vlastitu alatnu vrpcu s nizom gumba 
koji omogućavaju obavljanje poslova poput promjene pogleda 
prozora dokumenta, promjene režima rasporeda, dodavanje 
naslova stranice, probnog pregleda u pregledniku i još mnogo 
toga. Ranije u ovom poglavlju detaljno su objašnjene sve funkcije 
na alatnoj vrpci dokumenta.

Tag Selector Kad u pogledu Design odaberete neki element, Tag Selector 
prikazuje odgovarajuću HTML oznaku. To je brz i lak način za 
odabiranje pojedinosti na stranici. Ovaj alat ćete koristiti u mno-
gim poglavljima ove knjige.

Izbornik za  
zadavanje  
veličine prozora

Omogućava postavljanje veličine prozora na razne prethodno 
definirane veličine. Možete zadati i proizvoljne dimenzije u pik-
selima. Nema učinka na konačan raspored stranice, već je samo 
način da vidite kako će stranica izgledati pri različitim veličinama 
prozora.

Veličina stranice/
trajanje učitavanja

Prikazuje približnu veličinu (u kilobajtima) i trajanje učitavanja za 
tekuću stranicu. Odabiranjem Preferences > Status Bar možete 
promijeniti ovu opciju tako da izračunava vrijeme preuzimanja 
sukladno brzini pristupa Internetu tipičnog korisnika.

Alat Select Podrazumijevani alat kad se uređuje dokument. Omogućava 
postavljanje kursora na stranicu na koju treba upisati tekst, oda-
bir slika i tablica te rad sa svim elementima na stranici.

Alat Hand Upotrijebite alat Hand za pomicanje stranice u pogledu Docu
ment kad je uvećanje veće od 100% da biste mogli vidjeti dije-
love stranice koji su trenutno izvan vidnog polja.

Alat Zoom Odaberite ovaj alat da biste brzo zumirali određeno područje 
stranice. Kad odaberete alat Zoom, pokazivač će promijeniti 
oblik u povećalo pa ćete moći pritisnuti i povući te tako odabrati 
područje koje želite zumirati.

Povećanje Odaberite ovaj alat da biste brzo zumirali određeno područje 
stranice. Kad odaberete alat Zoom, pokazivač će se promije-
niti u povećalo pa ćete moći pritisnuti i povući te tako odabrati 
područje koje želite zumirati.
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23Poglavlje 2 : Upoznavanje sučelja

Pogledi prozora dokumenta
Dreamweaver pruža mogućnost pregleda stranica na kojima radite u jednom od tri 
pogleda: Code, Split i Design. Svi će se novi dokumenti podrazumijevano otvarati u 
pogledu trenutnog dokumenta. Ako trenutno nije otvoren dokument, otvorit će se u 
pogledu zadnjeg dokumenta koji ste otvorili. Prema tome, ako je zadnji dokument na 
kojem ste radili bio u pogledu Code kad ste ga zatvorili, sljedeći će se novi dokument 
otvoriti u pogledu Code. Tri gumba na lijevoj strani alatne vrpce omogućavaju prijelaz 
između tri različita pogleda.

Pogled Code

Pogled Split

Pogled Design
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Višestruki prozori dokumenata
Kad radite na lokaciji s više stranica, morat ćete imati nekoliko dokumenata otvorenih u 
isto vrijeme, što može biti tegobno za rad čak i ako imate veliki monitor. Dreamweaver 
CS3 olakšava rad s više prozora tako što stavlja jezičak za svaki prozor na vrh prozora 
dokumenta. Možete se prebacivati iz jednog dokumenta u drugi pritiskanjem jezička. 
Napomena: U Windowsima prozor mora biti maksimiziran da biste vidjeli jezičke, u suprot-
nom će se prozor pomicati uokolo kao zaseban objekt.

Jezičci olakšavaju kretanje kroz 
otvorene dokumente.

Palete i skupine paleta
Dreamweaver olakšava upotrebu inače složenog sučelja kroz sustav paleta (engl. panel) i 
skupina paleta (engl. panel group). Ova dva elementa sučelja rade zajednički kako bi vam 
olakšali prilagođavanje radnog prostora tako što omogućavaju brz pristup samo paletama 
koje su vam potrebne. Svaka skupina paleta može sadržavati nekoliko različitih paleta, od 
kojih svaku identificira jezičak. Svaki jezičak možete pritisnuti i tako brzo otvoriti paletu.

Gumb  
Panel Options

Skupine paleta sadrže dvije ili više paleta. Primjer prikazan na slici 
gore lijevo prikazuje skupinu CSS koja sadrži palete CSS Styles i AP 
Elements. Palete možete proširivati i sažimati pritiskanjem crne stre­
lice u gornjem lijevom kutu skupine paleta. Svim se paletama može 
pristupiti iz izbornika Window ili upotrebom prečaca na tipkovnici.  
Skupine paleta možete prilagoditi ili izraditi vlastite dodavanjem  

Ime skupine paleta

Proširivanje/
sažimanje skupine

Jezičak palete

Skrivanje/prikazivanje 
paleta (samo u 
Windowsima)
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i uklanjanjem paleta ako odaberete opciju Group <ime palete> with i Close < ime palete 
> s pomoćnog izbornika palete.

Skupini paleta možete promijeniti ime odabiranjem opcije Rename panel group ili možete 
izraditi novu skupinu paleta odabiranjem opcije Group < ime palete > with > New panel 
group s izbornika Panel Options. Ovo je izvrstan način za prilagođavanje sučelja. Palete 
također možete pritiskati i povlačiti da biste ih dodali ili uklonili iz drugih skupina paleta.

Podrazumijevano su sve skupine 
paleta usidrene uz desnu stranu 
zaslona. Skupinu paleta možete 
odvojiti pritiskanjem hvataljke 
(engl. gripper) u gornjem lijevom 
kutu skupine paleta te povlače-
njem na novi položaj.

Lako je možete ponovno usidriti 
pritiskanjem hvataljke i povla-
čenjem iznad bilo koje druge 
palete. Plava crta koja će se 
prikazati pokazuje mjesto gdje 
će se skupina paleta pojaviti kad 
otpustite tipku miša.

U Windowsima palete možete 
usidriti na lijevu i desnu stranu 
prozora dokumenta pritiskanjem 
hvataljke u gornjem lijevom 
području i povlačenjem uz desni 
ili lijevi rub prozora dokumenta. 
Debela crna crta prikazuje mje-
sto gdje će se paleta pojaviti kad 
otpustite tipku miša. Ako kori-
stite Macintosh, možete povlačiti 
palete i skupine paleta na lijevu 
stranu zaslona ali one se neće 
usidriti i promijeniti veličinu tako 
lijepo kao u Windowsima.

Mnogi korisnici Dreamweavera vole rasporediti palete na lijevoj i desnoj strani prozora 
dokumenta. Naravno, potreban vam je veliki monitor da biste učinkovito radili s paletama 
razmještenim na ovaj način. Zapamtite, nema ispravnog ili neispravnog načina da se ovo 
učini – to je jednostavno stvar osobne sklonosti.
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Povratak podrazumijevanog radnog prostora
Tijekom eksperimentiranja s različitim 
rasporedima i grupiranjima paleta, mogli 
biste zaključiti da je podrazumijevani ras-
pored Dreamweaverove radne površine 
bio bolji bez vaših promjena. Ako koristite 
Macintosh, podrazumijevane postavke 
možete vratiti odabiranjem opcije Window 
> Workspace Layout > Default. Ako 
koristite Windowse, također možete oda-

brati Window > Workspace Layout, ali 
umjesto Default možete odabrati između 
opcija Designer i Coder. U Windowsima je 
opcija Designer ekvivalent opciji Default 
na Macintoshu. Ona postavlja sve skupine 
paleta na desnu stranu sučelja. Opcija 
Coder je za programere koji uglavnom 
radije rade u pogledu Code pa, osim ako 
ne volite pisati kôd, odaberite Designer.

NAPOMENA: Opcija Dual Screen
U izborniku Window > Workspace Layout nalazi se i opcija Dual Screen. 
Namijenjena je korisnicima koji imaju dva monitora priključena na raču-
nalo. Ako ste jedan od tih sretnika, možete odabrati Dual Screen da 
biste skupine paleta razmjestili po drugom zaslonu i time na primarnom 
monitoru dobili više prostora za rad s Web stranicama.

Spremanje rasporeda paleta i prozora
Ako ste raspored radnog prostora prilagodili svo-
jim potrebama, vjerojatno ćete ga željeti spremiti 
da biste ga mogli ponovno učitati ako ga netko 
slučajno poremeti. Osim toga, mnogi korisnici 
rade na nekoliko različitih tipova stranica. Jedan 
dan možete raditi na dinamičkoj lokaciji i trebati 
paletu Application i Tag Inspector, a idući raditi 
na statičkoj XHTML lokaciji i trebati samo paletu 
CSS. Spremanje rasporeda radnih prostora omo-
gućava postavljanja rasporeda za svaki tip posla, 
tako da se lako možete prebacivati s jednog na 
drugi (ili treći ili četvrti).

Nakon što rasporedite palete i skupine paleta, 
odaberite Window > Workspace Layout > Save 
Current da biste otvorili dijaloški okvir Save 
Workspace Layout. Upišite ime pod kojim želite 
spremiti radni prostor i pritisnite OK.

Da biste pristupili prilagođenom radnom pro-
storu koji ste izradili, odaberite Window > 
Workspace Layout i zatim raspored koji želite 
upotrijebiti. Palete će se zatim same rasporediti.
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Zadavanje podrazumijevanog preglednika
Jedan od najvažnijih koraka u dizajniranju Web stranica je njihovo testiranje u različitim pre-
glednicima. U svojoj osnovi, Web stranica je samo gomila koda, bez obzira je li to XHTML, 
JavaScript, CSS ili neki drugi. Ono što vidite kad stranicu gledate u pregledniku zapravo je 
preglednikova interpretacija koda, a svaki bi preglednik mogao stranicu interpretirati drugačije. 
U današnje su vrijeme standardi preglednika postali malo pouzdaniji ali je još uvijek dobro stra-
nice provjeriti u što je moguće više preglednika prije nego što ih postavite na Web poslužitelj.

Naravno, možda ste ljubitelj nekog određenog preglednika pa ćete stranice dizajnirati 
isključivo za korisnike, na primjer, Firefoxa. To je u redu ako vam ne smeta što posjetitelji 
koji koriste druge preglednike možda neće moći vidjeti sadržaj stranica onako kako ste 
ga namjeravali prikazati. Ali, ako želite privući što je moguće više posjetitelja, željet ćete 
preuzeti i instalirati razne preglednike, kao što su Firefox, Netscape, Opera i mnogi drugi. 
Ako radite u Windowsima, na računalu biste trebali imati barem najnoviju inačicu Internet 
Explorera, Netscapea i Firefoxa. Ako koristite Macintosh, već biste trebali imati Safari, ali 
možda biste trebali također preuzeti i instalirati Firefox i Netscape. Ako zaista ozbiljno 
želite osigurati pravilno funkcioniranje stranica, mogli biste ih provjeriti i na drugoj plat-
formi – ako dizajnirate u Windowsima, stranice ćete provjeriti na Macintoshu i obratno.

Kao što ste pročitali ranije, Dreamweaver sadrži neke ugrađene alate za provjeru uskla-
đenosti koda stranica s različitim tipovima preglednika, ali ako želite znati kako stranica 
izgleda u izvjesnom pregledniku, u njemu ju trebate i pogledati.

Provjeravanje stranica u pregledniku nije nešto što biste trebali obaviti samo prije nego što 
ih prenesete na Web poslužitelj. Trebali biste ih provjeravati nakon svake faze rada, tako da 
moguće probleme možete rješavati kako se pojavljuju. 

Da biste zadali postavke preglednika, slijedite ove korake:

 1   Odaberite Edit > Preferences (Windows) ili Dreamweaver > Preferences (Macintosh).

 2   Na popisu Category pritisnite Preview in Browser.

 3   Pritisnite gumb +, - ili Edit da biste dodali, uklonili ili promijenili preglednik na popisu opcija.

Napomena: Opcija Primary browser zadaje koji se pre­
glednik pokreće kad pritisnete tipku F12 (Opt+F12 na 
Macintoshu). Opcija Secondary browser zadaje koji se 
preglednik pokreće kad pritisnete kombinaciju tipki 
Ctrl+F12 (Cmd+F12 na Macintoshu). Mnogi dizajneri vole 
pregledati stranice u više preglednika kako bi bili sigurni 
da uvijek izgledaju jednako. Zadavanje primarnog i 
sekundarnog preglednika omogućava da to lako obavite.

Postavka Preview in Browser zadaje primarni pregled­
nik koji se otvara pritiskom na tipku F12 (Opt+F12 na 
Macintoshu). Na popis možete dodati više od dva preglednika, ali samo primarnom i sekun­
darnom možete pristupiti upotrebom prečaca na tipkovnici. Ostalim preglednicima možete 
pristupiti preko gumba Preview in Browser na alatnoj vrpci dokumenta.
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Korištenje prečaca na tipkovnici
Dreamweaver CS3 ima puno prečaca na tipkovnici. Sljedeća tablica pruža popis nekih koji 
se najčešće koriste:

Prečaci na tipkovnici u Dreamweaveru

Akcija Macintosh Windows

Izrada novog dokumenta Cmd+N Ctrl+N

Prijelom reda Shift+Return Shift+Enter

Prikaz značajki stranice Cmd+J Ctrl+J

Odabir riječi Pritiskanje dvaput mišem Pritiskanje dvaput mišem

Odabir odlomka Pritiskanje triput mišem Pritiskanje triput mišem

Provjera pravopisa Shift+F7 Shift+F7

Pronalaženje i zamjena Cmd+F Ctrl+F

Vrpca Insert Cmd+F2 Ctrl+F2

Property Inspector Cmd+F3 Ctrl+F3

Paleta Behaviors Shift+F4 Shift+F4

Paleta Files F8 F8

Paleta Result F7 F7

Paleta History - Shift+F10

Paleta CSS Styles - Shift+F11

Spremanje Cmd+S Ctrl+S

Prijenos na poslužitelj Cmd+Shift+U Ctrl+Shift+U

Pregled u primarnom  
pregledniku

Opt+F12 F12

Pregled u sekundarnom  
pregledniku

Cmd+F12 Ctrl+F12

Prikaz ili skrivanje svih paleta F4 F4
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S AV J E T: Prilagođavanje prečaca na tipkovnici
Ako želite definirati vlastite prečace na tipkovnici, odaberite opciju izbor-
nika Edit > Keyboard Shortcuts, odnosno Dreamweaver > Keyboard 
Shortcuts. Možete mijenjati ili dodavati prečace prema svojim željama.

Dreamweaver CS3 
omogućava da 
zadate vlastite pri-
lagođene prečace 
na tipkovnici te 
odaberete između 
nekoliko unaprijed 
postavljenih skupova 
prečaca. Vlastite pri-
lagođene postavke 
možete spremiti i 
izvesti HTML dato-
teku koju ćete kori-
stiti kao podsjetnik. 
Ovo može biti zaista 
korisno ako, na pri-
mjer, na Macintoshu 
želite definirati 
prečace za otvara-
nje paleta History i 
CSS Styles kojima 
prečaci na tipkovnici 
nisu podrazumije-
vano pridruženi.

Pravi duplikat skupa

Izvozi skup u HTML datoteku

Mijenja ime skupa

Briše skup

U ovom ste poglavlju brzo razgledali sučelje Dreamweavera CS3 i naučili kako konfigurirati 
postavke Dreamweavera CS3 prema svojim željama. Nakon što ste se upoznali sa sučeljem 
alata, vrijeme je da započnete rad na Web stranicama. U sljedećem ćete poglavlju naučiti 
kako definirati lokaciju (engl. Web site) u Dreamweaveru CS3.
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